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Abstract: The retina encodes visual scenes by trains of action potentials that are sent to the
brain via the optic nerve. In this paper we describe a new free access user-end software allowing
to better understand this coding. It is called PRANAS (https://pranas.inria.fr), standing for
Platform for Retinal ANalysis And Simulation. PRANAS targets neuroscientists and modelers
by providing a unique set of retina-related tools. PRANAS integrates a retina simulator allowing
large scale simulations while keeping a strong biological plausibility and a toolbox for the analysis of
spike train population statistics. The statistical method (entropy maximization under constraints)
takes into account both spatial and temporal correlations as constraints, allowing to analyze the
effects of memory on statistics. PRANAS also integrates a tool computing and representing in
3D (time-space) receptive fields. All these tools are accessible through a friendly graphical user
interface. The most CPU-costly of them have been implemented to run in parallel.

Key-words: Retina simulator, spike train statistics, population coding, maximum entropy, Gibbs
distributions, large scale spiking activity, spike train generation, multi-electrode array recordings
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PRANAS: Une nouvelle plateforme pour I’analyse et la
simulation de rétines

Résumé : La rétine encode les scénes visuelles par des trains de potentiels d’action qui sont
envoyés au cerveau via le nerf optique. Dans cet article, nous décrivons un nouveau logiciel libre
d’accés qui permet de mieux comprendre ce codage. Il s’appelle PRANAS (https://pranas.inria.fr),
ayant pour signification Platform for Retinal ANalysis And Simulation. PRANAS cible les neu-
roscientifiques et les modélisateurs en fournissant un ensemble unique d’outils liés & la rétine.
PRANAS intégre un simulateur de rétine permettant des simulations & grande échelle tout
en conservant une forte plausibilité biologique et une boite & outils pour l'analyse statistique
des trains d’impulsion dans une population de neurones. La méthode statistique (maximisation
de entropie sous contraintes) prend en compte les corrélations spatio-temporelles comme con-
traintes, permettant d’analyser les effets de la mémoire sur les statistiques. PRANAS intégre
également un outil de calcul et de représentation en 3D (temps-espace) des champs récepteurs.
Tous ces outils sont accessibles grace a une interface utilisateur conviviale. Les plus cotiteux
d’entre eux en terme de temps de calculs ont été implémentés pour fonctionner en paralléle.

Mots-clés : Retina simulator, spike train statistics, population coding, maximum entropy,
Gibbs distributions, large scale spiking activity, spike train generation, multi-electrode array
recordings
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1 Introduction

The retina is one of the most developed sensing devices [21], B4, B5]. It transforms the incoming
light into a set of electrical impulses, called spikes, which are sent asynchronously to higher
level structures in the visual cortex through the optic nerve. Although Cajal’s neuron doctrine
was postulated more than one century ago, how information is encoded and transmitted by
neurons is still not entirely understood today. Especially, the role of spatio-temporal correlations
in population coding raises up deep theoretical and practical questions that are far from being
answered [49, [0], particularly for the visual information transmitted from the retina to the visual
cortex. To address these questions and make progress in their understanding, one needs to
develop joint modeling and experimental studies with efficient software to analyse data. In
this paper we present a new Platform for Retinal ANalysis And Simulation called PRANAS
(https://pranas.inria.fr). It was designed as a user-friendly tool dedicated to neuroscientist
community in a large sense, i.e., not only experienced computational neuroscientists. It has
two main goals, analyse retina data, especially spatio-temporal correlations, and simulate the
spike response of the retina to a visual flow. This makes this tool a unique platform to better
understand how the retina works.

The first goal of PRANAS is to provide methods to analyse retinal recordings at single cell
and population levels. With the advent of new techniques, the recording of the simultaneous
activity of groups of neurons provides a critical database to unravel the role of specific neural
assemblies in spike coding. The acquisition capacity of Multi-Electrode Arrays (MEA) has been
exponentially increasing over years [57]. Systems like the 256-MEA has become a standard
although new high-density MEA are now available such as the APS CMOS 4096-electrodes [15].
Using these systems, one can record from hundreds to thousands of neurons simultaneously in
the retina (and more generally in vivo or in vitro, from cultures of neurons, and from other
brain areas). As one gains more intuitions and results on the importance of concerted activity
in spike trains, models are developed to extract, from animal recordings, possible canonical
principles underlying spike coding. This is a major challenge with many potential outcomes.
Beyond the dream that population coding is ruled by a few first principles, several applications
could emerge such as the development of artificial systems having similar levels of performance
as biological systems. To this end, accurate tools are required to analyse and compare spike
trains, experimental or computer generated ones. Progress has been made recently to analyse
spike trains [53] B4, [32] [62], 61, 52, 61, B0]. Especially, the spatio-temporal aspects (memory)
and causality have been shown to be relevant for exploring neural activity [6]. For instance, [68]
and [60] demonstrated the importance of temporal statistics and [42], 40] developed new tools to
analyse spatio-temporal activity for large scale spiking networks. These methods shed a new light
on spike train analysis. However, they require time and expertise to be implemented efficiently,
making them hard to use. The idea of developing a new software came from our motivation to
share these recent developments with the neuroscience community in a broad sense. PRANAS
integrates all our expertise in terms of spike trains statistical analysis. Note that other methods
analyzing correlations in massively parallel data using completely different approaches have also
been proposed |26}, 59, 65], [47].

The second goal of PRANAS is to provide a customizable retina simulator which could evolve
in synergy with experimental data analysis. Currently, there is a large and expanding body of
literature concerning models of retinal processing. There are three main classes of models. The
first class regroups the linear-nonlinear-poisson (LNP) models [43]. LNP models can simulate
the spiking activity of ganglion cells (and of cortical cells) in response to synthetic or natural
images [3] but they voluntarily ignore the neuronal mechanisms and the details of the inner
retinal layers that transform the image into a continuous input to the ganglion cell (or any
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type of cell) stages. The second class of models has been developed to serve as a front-end
for subsequent computer vision task. They provide bio-inspired modules for low level image
processing. One interesting example is given by [2] 23], where the model includes parvocellular
and magnocellular pathways using different non-separable spatio-temporal filter that are optimal
for form- or motion-detection. The third class is based on detailed retinal models reproducing
its circuitry, in order to predict the individual or collective responses measured at the ganglion
cells level [44] 69, 3T, B3]. In PRANAS, we are interested in this third class of models because
they allow to explore several aspects of retinal image processing such as (i) understanding how
to reproduce accurately the statistics of the spiking activity at the population level [41], (ii)
reconciling connectomics and simple computational rules for visual motion detection [29] and
(iii) investigating how such canonical microcircuits can implement the different retinal processing
modules cited in, e.g., [2I]. More precisely, the PRANAS platform has integrated and extended
the VIRTUAL RETINA simulator [()9E| initially developed in our team to do large scale retina
simulations. VIRTUAL RETINA has been used in several theoretical studies |37, [39, [T}, 1T}, 12|
66

This paper, aiming at presenting this new platform PRANAS, is organized as follows. In
Sec. 2| we give an overview of PRANAS and compare it with a selection of other tools currently
available focusing on spike train analysis methods. In Sec.[3] we present the main features of the
software. Illustrations and step by step procedures are given in several cases allowing readers to
reproduce them. In Sec.[d] we discuss future developments.

2 General presentation

PRANAS targets a broad community of scientists interested in exploring spike coding, in par-
ticular at retina level. It provides new tools for analyzing spike trains at the population level and
several methods to generate them, either with a prescribed statistics (including spatio-temporal
correlations) or by emulating the retinal response to a visual scene. This is done through a user-
friendly Graphical User Interface (GUI). PRANAS runs on multiple platforms (Linux, Mac
OS, Windows) and it supports parallel architectures. The software is provided as binary code
or as source code on request upon acceptance on the terms of the license given on the website
(http://pranas.inria.fr). Documentation, tutorials, and samples of spike trains are also available.
The GUI of PRANAS (version 1.0.0) has three main panels, as shown in Fig.

e Function panel () is the main panel containing Input/Output interfaces and functions.
It is organized in three sections: Data, Analysis and Simulation. (see Sec. [3| for more
details).

e The parameter panel () allows one to set parameters related to the chosen function
from the function panel.

e The results panel () contains the results. Several results can be displayed simultaneously
in different subpanels, and each result can be exported as a figure in a variety of formats
(e.g., PDF, PNG, JPG). The user can change the Number of views and which result
should be displayed in each subpanel. In most subpanels, there are icons on the left-hand
side to open, save, export or change plot settings (see Fig. (c)) Another example is shown
in Fig. [[a) (Stimulus view) where the user can export, show/hide grid and spikes and
select neurons graphically.

IWVIRTUAL RETINA website: http://virtualretina.inria.fr
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Figure 1: Presentation of PRANAS GUI panels. (a) Function panel ([FP ) is the main panel con-
taining Input/Output interfaces and functions. It is organized in three sections: Data, Analysis
and Simulation. Note that in the Help option from the menu bar users can select Show bubble
help which will trigger tooltips giving information for each function. (b) Depending on the
function selected, the parameter panel () gives the opportunity to set the corresponding pa-
rameters. (c) Results panel ((RP]) can show all results the user want. The number of sub-panels
and the windows to show can be changed. Note that for each result shown in a sub-panel, the
user can customize the display or export it in different formats.

Finally, another convenient feature of the software is that user can save what he has done in
term of analysis in a HDFS5 file [70] (File>Save) and load it later to continue the work.

PRANAS is implemented in C++. It has its own dedicated libraries. It also uses other
libraries for storage (HDF5)), analysis (GSL, SEMT)), display and GUI (Qt4, Qwt, VTK, Clmg).
Some parts of the software, especially the statistical estimations, run on multiple processors
thanks to OpenMP)| framework. The software takes all the available processors in the machine
automatically, without any interaction with the user. Parallelization allows to boost heavy
computations and save processing time and memory.

To our best knowledge there is no other platform integrating together the functionalities pro-
posed by PRANAS, to both analyse and stimulate retinal activities. There are however several
platforms performing efficient spike train analysis. Table [I| provides a qualitative comparison
between PRANAS and a selection of such tools for spike train analysis. We note that the im-
plementation of PRANAS as a stand-alone application in C++/Qt4 rather than a library (such
as, e.g., the FIND toolbox) makes this tool readily available without the need of an external in-
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terpreter, such as Python or the commercially available Matlab suite (MathWorks, Natick, VA).
Thus, access to PRANAS functions from a scripted analysis is performed via command line calls

(see Sec. ).

CcX FD NT SL NY [0)'4 ET SR NE Sv PS
Version 2.12 2.0 2.0 1.00 0.1 0.3.5 0.3.0 0.3-2 5.037 0.4.2 1.0.0

Mat- Mat- Mat- Mat-
Language lab lab lab lab | Python | Python | Python | X VB Python | C-+
GUI [ [ ] [ [ ] [ ] [ ] [
Scripting [ J [ (] [ J [ J [ (] [ J [ J [ J
Free binary [ [ ] (] [ [ [ (] [ J [ [ J
File formats (Nex) ([ [ ] [ ] ([ (L [ ] [ ] ®
File formats (HDF5) (] (J [ [ ] ®
Rate histogram PSTH o [ J (] [ J [ J [ J
Population PSTH [ [ [ [ (] [ ] [ [ J
IST [ (J [ [ [ [ ] [ ] [ [ ]
Cross-correlograms [ ) ) [ ) o (] [ J [ J [ J [ ]
Joint spike and stimulus
visu. o
STA [ (J (] [ ] ®
PCA [ ]
Spectral analysis [ ] [ ) [ ) o [ ) [ J
MaxtEnt (x / x-t) GLM ([
Raster generation o (] [ J
.. with Poisson / Non
Poisson / o ® ¢
.. with VIRTUAL
RETINA o

Table 1:

Comparison between a selection of existing software for spike train analysis. Ab-

breviations for software names (first and last initials) have been chosen for the presentation.
Following software is discussed: CX: |CHRONUX [27], FD: FIND| [38], NT: NSTAT [20],
SL: sicTOOL [30], NY: NEUROPY [56], OY: |OPENELECTROPHY [I8], ET: ELEPHANT, SR:
STAR/ [45], NE: NEUROEXPLORER, SV: SPYKEVIEWER)| [40], and PS: PRANAS. Note that
features selected in this table have essentially been chosen according to what PRANAS does.
It is not an exhaustive list and information applies to the time of writing. Software we mention
can have additional features not commented herein.

3 PRANAS main functions

3.1 Data

In section Data, user can load spike trains files. Spikes may come either from real cells recordings
or from a simulated spiking neural network. They can be imported from different formats such
as simple text file (.txt), DAT file for Windows (.dat), NEXUS file (.nex) or HDF5 file format
(.hdf5, see [70]) allowing to store not only the spikes but also other information related to
experimental protocole (e.g., time stamps, MEA characteristics).

Depending on how the spikes were generated, the user can also load other information such
as:

e The MEA configuration for animal cell recordings, allowing the spiking activity to be
displayed relative to the grid of electrode.

Inria
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e The sequence of images in case of a visual experiment, allowing the spiking activity to be
displayed together with the stimulus but also to emulate a retinal response (see Sec.|3.3.2).

e The image time stamps, i.e., the precise time at which each image was shown, allowing to
perform Spike-Triggered-Average (STA) [g].

3.2 Analysis
3.2.1 Classical analysis

Once the spikes are available (simulated or imported), different analysis can be performed start-
ing with basic visualizations and classical analysis such as peri-stimulus histogram, interspike
interval, and cross-correlation (see Fig. 2] and Example[I). The number of neurons used for the
analysis can be of several thousands, although the user can select subsets of neurons according to
different criteria, e.g., individual activity or receptive field localization (if applicable, i.e., if data
allows to compute receptive fields). Even for a large population of neurons (about 4000 neu-
rons), on any modern computer, the computational time of most of the functions in the classical
analysis is neglectable.

Example 1 How to obtain the peri-stimulus time histogram (PSTH) on a selection
of neurons having the highest spike rates?

1. Data>Spikes>0pen

2. Browse and select the file of spikes.

3. (Optional) In the sub-panel showing the list of neurons, click on Spike rate to
sort neurons with respect to their averaged spike rate, select the set of neurons with
higher spike rate and click on Keep selected.

4. Analysis>Peri-stimulus time histogram.

5. Choose the bin size (time step) in milliseconds and click on Compute.

3.2.2 Population analysis

With the current evolution of Multi-Electrode Array (MEA) recordings devices, it is possible to
record simultaneously thousands of neurons [I5]. This opens up the possibility of analysing the
collective neuronal population activity, namely its spatio-temporal correlations. Characterizing
spatio-temporal statistics is a fundamental step toward extracting general population coding
principles in neuronal networks. For example, it has been observed in several vertebrate species
that, even if the pairwise correlations of retinal ganglion cell are weak, they are necessary to
explain the statistics of spikes [19] 22| 53], 54| [62].

Analysing spatio-temporal correlations is, however, a notoriously hard problem from a sta-
tistical perspective. The point is not only to measure pairwise or higher order correlations
but also to address adequately the question of their significance in neuronal coding taking into
account constraints such as limited statistical sample, the reliability of statistical tests, the hy-
potheses underlying mathematical models and risks of overfitting [51, [52]. One possible way
of solving this problem is to use Gibbs distributions. Initially introduced in statistical physics
by Boltzmann and Gibbs [28] but currently used in a broader context, this general class of
probability distributions, constitutes a canonical paradigm to explain the spike statistics repro-
ducing as close as possible empirical correlations, without adding additional unnecessary assump-
tions [53], 54l 32, 6], 16, 17, 62 6I]. This method has been used to study pairwise correlations
(see [68], [42], 40] as well as more general spatio-temporal correlations [7, 67, [, [42] [10] 24 48], 25].
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Figure 2: Example of classical analysis for a spike train shown in sub-panel (a). The following
estimations are shown: (b) Inter-spike interval (ISI), (c) Peri-stimulus time histogram (PSTH)
and (d) cross-correlogram. Data from electrode array recording of a mouse retina in response to
a moving pattern.

PRANAS provides a toolbox to compute a Gibbs distribution from the neuronal data i.e., to
estimate a probability distribution, reproducing as close as possible empirical space- and time-
statistics of a raster, without adding additional unnecessary assumptions (maximizing entropy)ﬂ
In the current version, the population analysis toolbox of PRANAS focuses on stationary distri-
butions, i.e., the statistics are invariant under time-translation. We give first a brief explanation
of Gibbs distribution before explaining how to use PRANAS (see [67, 42], [40] for more details).

Below, rasters are denoted by w. We assume that time has been discretized with some time
bin.The state of neuron ¢ at time ¢ is denoted by w;(t) € {0,1}. We note by w(t) the vector
w;(t) (it tells us the spiking state of neurons at time t). Therefore, a raster w is mathematically
a matrix with N lines (number of neurons) and 7' columns (time bins in the raster). Obviously,
it is not stored this way in memory (we do not store 0s). A Gibbs distribution is a probability
measure u defined by a function F (also called "energy"). The probability of observing a raster w
of time length T, ;1 [w] is proportional to e#“) where F(w) = Zt 1 ¢(w(t)). In the following ¢ is
called "potential". A paradigmatic example of Gibbs distribution appears in the Ising E| model.
Here ¢p(w(t)) = >, biwi(t) + >_; ; Jijwi(t)w;(t) where the sums hold on neurons indices. The
terms b;, J;; are parameters tuning the probability whereas the terms w;(t),w;(t)w;(t) depend
on the spike configuration and are called "interactions" (self-interaction for the term w;(t), and

2Note that this toolbox first motivated the creation of the GUI to manipulate these complex notions. In former
publications, software was named ENAS standing for Event Neural Assembly Simulations. After fusing of ENAS
and the retina simulator VIRTUAL RETINA (see Sec. into the same platform, we decided to choose a
better suited name (PRANAS) to describe the functional scope of this unique platform allowing to (i) analyse
spike trains coming from simulations or MEA recordings, at single cells or population levels, (ii) simulate retinal
spike trains from a bio-plausible model, (iii) use additional dedicated tools for retinal recordings.

3The model initially proposed by Ising and Lenz in 1920 had only nearest neighbours interactions and constant
couplings. The potential form we use corresponds in fact to a spin-glass but we use here the terminology found
in computational neuroscience papers.

Inria
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pairwise interactions w;(t)w;(t)). Here parameters b;, J;; are independent on time (stationarity
assumption) so it is sufficient to define the potential ¢ at time ¢ = 0.

In the Ising model, there is no coupling of spikes at different times so that the probability of
observing a raster of length T factorizes into probabilities of spike states w(t): consecutive time
events are therefore independent. We say the statistical model has "no memory" in contrast
to the Markovian model presented now. A natural generalization of the Ising form is indeed to
define the potential ¢ as:

L
o(w) =Y hm(w) (1)
1=0

The terms h; are parameters tuning the probability. They correspond to b;, J;; in Ising model
but they tune more general spike interactions. Again, these parameters are independent of time
(stationarity) so that we can define the potential ¢ starting from an initial time 0. The main
difference with Ising model is that now interactions involve spikes at different times tq,...,¢t,.
These interactions correspond to the terms m;(w), with the general form wj, (t1)...w;, (t,), i.e.
it involves spike events occurring at different times. As an immediate consequence, consecutive
time events are not independent anymore. One can show the Gibbs distribution is, in this case,
the invariant probability of a Markov chain. Thus, statistics involves memory and has nonvan-
ishing time correlations. For historical reasons, related to the development of our research work,
we call from now the my;s "monomials" instead of "interactions". The monomials correspond
thus to the conjunction of events in the raster, varying the space and time. For instance, the
condition “neuron zero is firing at time one, neuron two is firing at time zero and neuron three is
firing at time two” corresponds to m(w) = wo(1)w2(0)ws(2). More generally, the times ¢ defin-
ing a monomial are chosen in the interval [0, D] where D is a positive integer characterizing the
memory depth of the Markov chain associated with the Gibbs distribution. The model range is
given by R = D+ 1. The potential range is directly connected to the complexity of the algorithm
analyzing data, as the higher the range the higher the computational time and memory load.
Gibbs distributions satisfy a variational principle: maximizing the statistical entropy under the
constraints that the average value of each monomial, i [m;] has a fixed value. Gibbs distribu-
tions are thus also called Maximum Entropy (MaxEnt) distributions. In our case, this value is
equal to average empirical value m[m;] computed from an experimental raster. In other words,
here is what our algorithm does: given an initial form of the potential ¢, fixed by the user (see
below), one seeks the parameters h; maximizing the statistical entropy under the constraints
w[my] =m[m]. In general, it is not possible to have the strict equality p[m;] = 7w [m;] so one
tries to approach it at best. Equivalently, we minimize the Kullback-Leibler divergence between
i, the "model" and 7 the empirical measure ("data"). In the ideal case of a raster infinite
in time, this is a convex problem, and therefore there is a unique solution. For the realistic
case, the input raster is finite, and several solutions can solve the problem [6]. The algorithm
starts from an initial guess of the h;s and computes the corresponding averages p(m;) using a
Monte Carlo method. From this, it computes a variation of the h;s giving, if possible, a lower
Kullback-Leibler divergence (see [40] for details). We proceed this way until no improvement in
the Kullback-Leibler divergence is observed any more. At this point, modifying some parameters
(see next paragraph) can nevertheless still improve the minimization.

Let us now describe how to compute Gibbs distributions with PRANAS. There are many
(an exponential number) a priori possible potentials. In PRANAS we propose four predefined
potentials although the user can also define his own one. The options are the following. Here we
characterize the potential by the list of monomials M which compose it.

e Bernoulli model: It takes into account individual neurons activity where all neurons
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are independent. The potential reads ¢(w) = Zfil hjw;(0) where N is the number of
neurons. Hence, monomials are of type “neuron ¢ is firing at time ¢’ (Example: M =
{w1(0), w2(0),ws(0)} for 3 neurons). This model has range 1 .

Ising model: This paradigmatic model from statistical physics has been used in neuro-
science in several papers such as [53] b4, 63, [64]. The corresponding potential has been
introduced above. The monomials are of type “neuron i is firing at time ¢’ and “neu-
ron ¢ and neuron j are simultaneously firing at time t”. Thus events are instantaneous,
and this model does not involve memory and causality (consecutive times are indepen-
dent under p, the Gibbs distribution). This model has range 1 (Example for 3 neurons:
M = {w1(0), w3(0), wa(0), i (0)ws (0), wi (0} (0), wa (0)ws (0)})-

Pairwise + Triplets model: This model has been introduced by [I6, [I7]. In addition to
Ising terms, there are triplets of interactions (e.g. wi(0)wz2(0)ws(0)). This model too has
range 1.

Pairwise model. This is an extension of Ising model where monomials are of type “neuron
1 is firing at time ¢’ (single events) and “neuron ¢ is firing at time ¢ and neuron j is
firing at time ¢ + k7, 0 < k < D (pairwise events). This model integrates memory and
causality via time dependent pairwise interactions. (Example with range 2 and 2 neurons:
M = {w1(0), w2(0), w1 (0)w2(0), w1 (0)ws (1), w2 (0)wz(1), w1 (0)ws (1), w1 (1)w2(0)}).

User. Here the user defines his own potential (Example M = {w1(0),w2(0), w3(0)
w1 (O)WQ(I)UJg(Q), e })

Example 2 How to calculate the Gibbs distribution of a spike train?

1. Data>Spikes>0pen
2. Browse and select the file of spikes.

3. (Optional) In the sub-panel showing the list of neurons, select a subset of
neurons and click on Keep selected.

4. Analysis>Popu1ation analysis.

ot

Define the Potential, either from a file or by setting the type (e.g., pairwise)
and the rangeﬁ (e.g., R=3). Set the Maximal pattern length. For example, if
you select 2, the program will seek in the data all spike events occurring within
2 successive time steps, and compare the probability of these events, predicted
by the model, to the empirical probabilities. In Simulation, choose what you
want to compute. Possible choices are:

(i) Potential: Fits the coefficients of the potential.

(ii) Kullback-Leibler divergence: an estimation of Kullback-Leibler diver-
gence derived from the entropy estimation in [58] and the classical relations
between K-L divergence, p average of ¢ and entropy [6].

(i) Pattern probabilities: The confidence plot.
6. Analysis>Popu1ation analysis>Parametric potential

4The product N x R somewhat defines the complexity of the model. The larger N x R the longer the simulation

and the memory load. We have been able to run up to N = 100, R = 2 in reasonable times. Note however that the
statistical estimation of a so-huge number of neurons raises the classical problems (not inherent to our method)
of statistical estimation on a sample, which, e.g. for the retina rarely exceeds a few millions of spikes.
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7. Choose Initial coefficients: possible choices are Current (in the case
when you have made a run before and you want to keep h;s) or 0. For the
first run you can choose both as the initial parameters are anyway set to 0 (this
corresponds to start from a Bernoulli models where spikes are independent with
probability of occurrence 1). Set parameters of the Monte Carlo method to
speed up the process (see text for the role of each parameter).

8. Population analysis

9. Compute to do the estimation. The red bar at the bottom indicates that
computation is in progress.

Note that in PRANAS the user can fine-tune the probability estimation and speed up the
computation in the first steps of the Monte Carlo method by acting on the following parameters
(in Analysis>Population analysis>Parametric potential):

e Convergence bound: The lower bound of error you require. Simulations stops when the
code reaches this value.

e Tolerance Coefficient: Allows to filter monomials to compute h;s. For example, if
the event m; appears only, say 3 times in the raster you may consider that it is not
significant and must be eliminated from the potential . In this case you set Tolerance
Coefficient to 3.

e Raster length: The length of the Monte Carlo raster used to compute the average of
monomials for the current values of h;s. This number must increase as you get closer to
the solution (typically when you do not get any improvement in the error).

e Spike flips coefficients: This defines the number of flips per neuron and per iteration
in Monte Carlo methods [40].

e Delta: If the distance between predicted and empirical distribution is smaller than Delta
the Monte Carlo raster is not recomputed. Instead, the average value of monomials is
computed via linear response [40]. The number must be decreased as you get closer to the
solution (typically when you do not get any improvement in the error).

e Number of parallel iterations: We use two kinds of updating, based upon [14]: paral-
lel or sequential. Parallel update sets all h;s in one step. Number of parallel iterations
tells how many parallel updating of ;s are done before the program stops (and e.g. plots
the confidence plot, when selected).

e Number of sequential iterations: Sequential update. It computes only one h; at each
step. It is better to use it at the end of the computation, to fine-tune coefficients.

Figure [3| shows different visualizations of the results. In (a), we show a graphical view of the
potential’s coefficients. In (b), we show the literal form of the potential ¢(w). In this example,
it is

d(w) = — 0.860273 w1 (2) — 0.715493 wo(2) + - - - — 0.280176 wp(2)w2(2) (2)
+ -+ —0.120281 wo(2)ws(2)ws(3) + ...,

where, e.g., wo(2)wz(2) corresponds to the event "neuron zero and neuron two are firing at time
two whereas —0.280176 is the corresponding coefficient h; of this term in the potential. In (c), we
show a plot of monomials average value, with empirical average on the abscissa and theoretical
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average (predicted by u) on the ordinate. In (d), we show the evolution of the Hellingerﬂ distance
between the model predictions and empirical data, versus the number of iterations. Hellinger
distance is natural here as it relies directly on the estimation of the average value of monomials.
It provides a quantitative measure of the goodness of fit. Finally, in (e) we show a confidence plot.
This figure consists of plotting, in log scale, on the abscissa the empirical probability of observed
spike blocks and on the ordinate the expected probability of those blocks for the model u. If the
matching were perfect one would have all points aligning on the diagonal. This perfect matching
is only possible, however, if the input spike train were infinite. For finite spike trains fluctuations
about the exact probability are observed, ruled by Central Limit Theorem. Namely, fluctuations
are Gaussian with a variance o;, depending on the monomial [ and proportional to ﬁ, T
being the raster length (number of time bins). Around the diagonal are drawn error bounds
corresponding to 30y, where ¢ is an estimated empirically. These bounds define a confidence
region: if the Gibbs distribution is a perfect estimation of the input raster then points in the
confidence plot are distributed inside the confidence region with a probability of 99.7% of the
expected averages. The confidence plot provides a qualitative measure of the goodness of the fit.

Reducing the computation time has been a primary concern for us during the development
phase. In fact, the most time-consuming routine of PRANAS is for inferring the Gibbs Potential.
To face this problem, we introduced a new algorithm based on Monte Carlo sampling [42]. For a
large number of neurons, the Monte Carlo-based algorithm offers better computation time than
the algorithm proposed in [67]. With a cluster of 64 cores of 2.4GHz speed, PRANAS needs the
following amount of time to compute a target distribution (1 iteration): 5 min. for 20 neurons
with a pairwise model R = 2, 10 minutes for 40 neurons with an Ising model. To infer the
Gibbs Distribution, one needs 100-200 iterations on the h; estimation. For more details on the
scalability of this method see [42].

3.2.3 Receptive fields estimation

Beyond tools to analyse spike trains at the single cell and population levels, PRANAS provides
specific instruments in the case when spike trains come from evoked activity of neurons from the
retina. The user can upload MEA characteristics, the sequences of images of the stimulus and
the time stamps. Given this information, PRANAS provides a method to estimate the neuron’s
receptive fields. The method available in version 1.0.0 is Spike Triggered Average (STA) [§].
The STA can be computed for a single neuron, a subset of neurons or the entire population.
Example [3| describes the general procedure.

Example 3 How to estimate receptive fields with STA method?EI

1. Data>Spikes>0pen

2. Browse and select the file of spikes. Note that the user can select a subset
of neurons as in Example [I]

3. Data>Mu1ti—E1ectrode Array>Settings

4. Define the MEA configuration, so that, if neurons have a position relative
to the array, the spike activity can be displayed at the correct location.

5The Hellinger distance between the empirical probability @ and the Gibbs probability p is d(m,p) =

2
L
%\/21:1 (\/W(mz - \/M(ml)> :
6To test this example, one can use sample data available on PRANAS website: recording called mouse-

P39 17 06 14 (We are indebted to Evelyne Sernagor and Gerrit Hilgen, Newcastle University, who provided us
these data and authorized us to use them as a basis for examples.)
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File Help
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Figure 3: Population analysis view with N = 10, R = 2. (a) Graphic view of the potential’s
coefficients values; the abscissa corresponds to an index associated to a prescribed order on
monomials: the N first coefficients corresponds to single events (hence are related to firing rate);
by clicking on the histogram bar one makes appear the coefficient value and the corresponding
monomial. Ordinate give the value of the coefficient attached to the corresponding monomial.
(b) Literal form of the potential. (c) Theoretical average value of monomials versus their empir-
ical average value. To which extents the model predicts the empirical data is drawn with this
representation. This allows checking that constraints on empirical averages are respected by the
model. (d) Decay of estimation errors versus the number of iterations allowing us to graphically
check the convergence of the estimation algorithm (red curve). In the figure several successive
runs have been performed. The blue curve shows the evolution of error after each of these trials.
(e) Confidence plot. Cy, Cy, corresponds respectively to the upper and lower 30 bound associated
with Central Limit Theorem (see text).

5. Stimulus view shows the activity of individual neurons w.r.t. MEA array.
The user may choose a region of interest to select a subset of neurons. Note
that if you have a TEXT file for spikes, no position is available, and we chose
to arrange neurons following their order, by rows and columns.

Data>Stimulus>Open

&

7. Browse to choose the directory containing the sequence of white noise im-
ages. Note that all images should be in this directory and ordered by name. All
standard formats are accepted (e.g., PNG, JPG, TIFF).

8. Data>Stimulus>Time stamps: Time stamps of the exact offset of each
image during the experiment.

©

. Browse and select the file. Time stamps can be imported from a .txt (row
n contains the starting time of image n) or HDF5| [70].

10. Analysis>Receptive fields>Compute via STA
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Figure 4: Receptive field estimation using the STA approach. (a) White noise image sequence
with spiking activity superimposed as red dots. (b) 3D volume visualization of the receptive field
of one neuron. (c¢) Temporal slices of the receptive field (RF(-,-, z)). Slices are in increasing time
order from top to bottom and left to right. Time period between two slices is 33ms. (d) Temporal
profile passing through the peak activity location of the spatio-temporal volume (RF(x s, yar, )
where (zar,ynr, 20) = argmax, ,  RF(z,y, 2).

11. Output directory: Choose the directory where the receptive fields will
be saved, as a sequence of PNG files and in HDF5| format. Choose the num-
ber of images to be averaged before each spike with Time depth (number of
slices). Then click on Compute.

12. Analysis>Receptive fields>Display allows four types of visualization.

13. The user can display the receptive field of interest by selecting the neuron
in Receptive Fields subpanel and Update views.

A receptive field is stored in a regular grid in a three-dimensional space. Each voxel in
that grid, denoted by RF'(z,y, z), stores the value of the receptive field at each spatial position
(x X 84,y X sq) and temporal depth z X tg, where s4 and t; denote respectively the spatial
and temporal resolutions. The temporal resolution is estimated from the time stamps file as
the average difference between two successive time stamps. The number of time slices of the
receptive field, ny, is a user-defined parameter. The first spatial slice (x,y,z = 0) corresponds
to the average spike triggered stimuli at time —(ny — 1)td before the spike, the second slice
(x,y,z = 1) corresponds to the average spike triggered stimuli at time —(ny — 2) x tq before
the spikes and so on. In PRANAS we propose several displays of that volume (2D and 3D), as
illustrated in Fig. [4

The time spent on the estimation of receptive fields depends on the parameters. For example,
on a computer equipped with a Intel Core i7@2.8GHz and 32 GB of memory it takes about two
minutes to estimate the receptive fields of 4000 neurons with 64x64x12 voxels each.
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3.3 Simulation of spike trains
3.3.1 Simulation of spike trains from statistics

PRANAS gives the possibility to generate spike trains from Gibbs distributions. This can
be useful if, for example, one wants to generate spike trains with prescribed spatio-temporal
correlations so as to test a statistical method of analysis. There are two different ways:

1. Simulation>ComputeSpikes>GibbsRaster>current: if distribution comes from a
population analysis (see Sec. [3.2.2)).

2. Simulation>ComputeSpikes>GibbsRaster>File: if distribution has been defined by
the user and stored in a file containing the Gibbs potential form.

A Gibbs probability distribution (defined by Gibbs potential of the form ) is naturally
associated with a Markov chain, with memory D = R — 1, whose transition probabilities can
be computed from the potential ¢ [68 [6, 10]. The invariant distribution u of this chain is the
Gibbs distribution associated to ¢. Therefore, given a potential of the form it is easy to
generate a sample raster distributed according to p using Monte Carlo method [42]. PRANAS
affords this functionality allowing to generate rasters with spatio-temporal correlations tuned by
the parameters h; in ¢.

3.3.2 Simulation of spike trains from a retina simulator

Another strength of PRANAS is to provide a way to generate spike trains that mimic retina’s
outputs. To do so, PRANAS has integrated and extended the VIRTUAL RETINA simulator
[69] formerly developed in our teamm

In a nutshell, VIRTUAL RETINA is a software to perform large-scale simulations of
biologically-plausible retinas. Given a retina configuration which can be fully customized and an
input video as visual stimulus, VIRTUAL RETINA simulates the spiking output for different
cell types. VIRTUAL RETINA has been shown to reproduce a broad range of experimental
data at single cell level, from salamander, cat and primate retinas, and has been used in several
theoretical studies [36, 37, [39, [, 11 12} 66]. The underlying model includes a non-separable
spatio-temporal linear model of filtering in the Outer Plexiform Layer, a shunting feedback at
the level of bipolar cells, and a spike generation process using a network generalization of the
noisy leaky integrate-and-fire neurons to model Ganglion Cells (GCells). Note that VIRTUAL
RETINA was designed to be used via a command line (there was no GUI available).

By integrating VIRTUAL RETINA software into PRANAS platform, we allowed this
simulation software to be used through a GUI. We also extended VIRTUAL RETINA with the
aim to reproduce statistically coherent responses at a population level. Indeed, outputs of the
initial VIRTUAL RETINA version were successfully compared to experimental data at single
cell level but could not reproduce collective statistics at a population level. This is because GCells
in the early version were not connected. They were modelled by independent leaky-integrate and
fire neurons receiving their input from bipolar cells, but with no lateral connectivity (due to
amacrine cells - ACells - in the retina). As a consequence correlations in GCells spikes were only
due to statistics of the stimulus and overlapping receptive fields.

In the new version of the retina simulator embedded in PRANAS, GCells are connected
laterally so as to explore the effects of connectivity on retinal responses to stimuli. More precisely,
the IPL is now composed of discrete time leaky-integrate and fire neurons introduced in [55] and

"VIRTUAL RETINA website: http://virtualretina.inria.fr. VIRTUAL RETINA is under Inria CeCILL-C
license, IDDN.FR.001.210034.000.S5.P.2007.000.31235.
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studied mathematically in [4, B5]. We have chosen this model because of its simplicity, fast
response, and the fact that its collective dynamics are well known. In a nutshell, the model
comes from the time discretization of the leaky-integrate and fire model whose sub-threshold
dynamics reads:

C% =—gr.(V—=V)+1(t)+opB(t), (3)

for V' < 6, where 6 is the firing threshold. Here C is the membrane capacity, g the leak
conductance, Vr, is the leak reversal potential, B(¢) is a Gaussian noise (mean zero and variance
1) and op controls the amplitude of this noise. Finally, I(¢) is an external current. In our case,
this is the bipolar current coming from the OPL (see [69] for details).

Let 71, = g% be the leak characteristic time. We consider now a time discretization with a

time step dt (here it is fixed, dt = 1ms) and we set v = (1 — :—%) Note that dt has to be quite

smaller than 77, to have a reasonable description of the biophysics. Therefore v € [0,1]. Then,
the full dynamics (below and above threshold) of the membrane potential V; of neuron i is given
by:

I(t
Vit + 1) = Wi - 20+ O 1 %)
where Z is the binary spike label:

Zi:{l’ if V; > 0;

0, otherwise.

Thus Z; is 1 whenever neuron ¢ spikes. Here 1 — Z; models the reset. In this equation, neurons
are not coupled. We add then a connectivity through synaptic weights W;; where neuron j (pre
synaptic) acts on neuron i (post synaptic) upon spiking. We have now:

L) 1 on
Vit +1) = Vi1 = Z) + =57 + 5 2 WisZ + 5 B(®). (4)

For a complete description see [4,[5]. Clearly, this modelling of lateral connectivity, although usual
in the field of neural networks models, is rough when compared to the real lateral connectivity in
the IPL involving amacrine cells having a complex dynamics. Elaborating more realistic coupling
is under current investigations.

The simulator allows to tune the parameters leak (v € [0,1]); neuronal noise (o5 > 0);
membrane capacity (C); threshold (#) and the connectivity matrix (). The connectivity be-
tween neurons is set through the connectivity matrix. One can simulate independent neurons
by choosing none or connected neurons using sparse or dense schemes. One can also upload a
predefined connectivity matrix offering the possibility to explore its impact on spike statistics.
For example, we provide on the website an example of ACells-like connectivity pattern.

Example [4 shows how to generate spikes using PRANAS and Fig. [j] illustrates an example
of simulation. Note that user can find online retina configuration files and videos sequences to
test the simulator.

Example 4 Running the retina simulator

1. Data>Stimulus>0Open

8To run this example one can use data available on PRANAS website, for example the martin-walk image
sequence and the cat_X_cell_DLIF.xml retina configuration file which corresponds to the result shown in Fig. @
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Figure 5: Spike generation from our retina simulator. (a) Input image sequence with spiking
activity super-imposed (white blobs). (b) Connectivity matrix chosen for the simulation, here
random. (c¢) Simulated spike train.

[\

. Browse to choose the directory containing the sequence.

w

. Stimulus sequences subpanel: The sequence of images is loaded with a
default display duration of 100ms per image (Display time column). This value
can be manually set or defined from time stamps file (see Example [3]).

4. Simulation>Virtual Retina>Retinal conf iguration>0pelﬂ

(@1

. Browse and select the XML files containing the parameters of the retina.

=2}

. Simulation>Virtual Retina>Retinal configuration>Customize: Once
loaded, the user can still change parameters of the retina.

7. Simulation>Virtual Retina>Compute spike.

8. Compute to get the spikes.

The time spent in the generation of spikes with the retina simulator depends on the param-
eters. For example it takes about six minutes to generate the spikes corresponding to Fig. [f
on a laptop equipped with a Intel Core i7-6820HK CPU@2.70GHz. This was obtained with the
image sequence martin-walk (200x200 pixels, 41 frames) and the cat_X_cell_DLIF.xml retina
configuration file (100 neurons, sparse connectivity with 1000 connections out of 10000 possible
connections).

9Note that steps 4-6 can be skipped and one can directly generate spikes in step 7 using a proposed default
configuration.
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4 Conclusion

In this paper we have introduced PRANAS, a new fredEI platform for retinal analysis and
simulation. PRANAS provides a retina simulator allowing to transform any video into spike
trains, together with sophisticated methods to analyse spike trains, coming from simulations but
also experiments. As explained, PRANAS (version 1.0.0) includes a range of original methods
from the state-of-the-art [6] [69] which are now available to the neuroscience community. More
precisely, PRANAS intends to be useful for the neuroscience community in a large sense, i.e.,
not only experienced computational neuroscientists. To do so, we decided to make all methods
implemented therein accessible through a friendly GUI. No scripting is needed to run analysis and
simulation methods. This represents a major advantage to promote interdisciplinary neuroscience
and we believe that PRANAS helps in this direction.

However, we are certainly aware that this advantage could also be seen as a limitation of
the software. Indeed, inability to script analyses could be a limitation that can make systematic
analysis of large datasets tedious and error prone. It makes also difficult to link the functionalities
of this toolbox to more extensive data analysis workflow. For thoses reasons, we also offer some
functionalities that run on the command line. A non-exhaustive list of tools that can be used
from the command line is SimulateRetina (simulate retinal response), Correlations (compute
the average cross-correlations of a given raster), SpikeTriggerAverage (compute the average
spike triggered stimuliﬂ We expect to have the platform fully available with scripting in a
forthcoming version.

In this first release of PRANAS, we have focused on the following aspects:

e The user experience: We optimized the ergonomics of interactions between the user and
the interface. No scripting is needed to analyse or generate the spike trains.

e The richness of toolboxes: We developed a variety of methods ranging from classical tools
to population analysis, including a method for receptive fields estimation. In addition, we
provide two simulators, one inspired in the retina, the other from rasters statistics analysis.

e The computational performance: We parallelized a selection of functions to make possible
to handle faster large populations of neuronﬂ

By putting together functions related to retina simulation and analysis, PRANAS intends
to be an original platform that will encourage joint modeling and experimental studies. The
synergy between these two areas of functionality will be in particular useful to define better
retina simulators by confronting simulated output w.r.t. real cell recordings. A typical use case
is to start from a real cell recording of a retina, to analyse its receptive field structure, and use
that information to define the XML retina configuration file so to define a virtual retina having
similar characteristics as the real one. Another use case that we target is to start again from
a real cell recording of a retina, analyse spike train statistics and compare them with the ones
given by the simulator. Such a comparison is very informative and will suggest improvements of
the retina simulator to increase its biological plausibility.

LOPRANAS is under Inria CeCILL-C license, IDDN.FR.001.190004.000.S.P.2014.000.31235. Binaries can be
freely downloaded.

1 These commands can be found in the directory pranas/bin. Help of each tool is given with the command
line: toolName -h.

12Parallelization concerns every loop in our C++ code where iterations can be computed independently. To do
so, we used OpenMP so that PRANAS parallel processes can run on a personal computer equipped with multi-
core processors. More precisely, four functions were parallelized: (i) the loading of rasters for all file formats, (ii)
the statistical analysis functions to generate potentials, compute divergence and estimate patterns probabilities,
(iii) the estimation of receptive fields and (iv) the retina simulator.
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Here, we presented its main features, and we refer the interested reader to its websitﬁ for
downloads and more information (see, e.g., tutorials to get started). We hope that PRANAS
becomes a useful tool for neuroscientists to analyse spike trains and we expect to improve it thanks
to the users’ feedback. Our goal is to progressively enrich PRANAS with the latest research
results, to facilitate the transfer of new methods to the community. Future work will focus
on improving several existing functions regarding efficiency in time and memory consumptions.
We will include methods for population analysis in the non-stationary case as well as other
statistical analysis models. We are working on better methods for receptive fields estimation [I3].
We are also developing extensions of the retina simulator model so that it could serve as a
satisfactory model at a population level. Finally, as a general objective, we also plan to improve
the computational power of PRANAS in order to handle even larger networks.
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